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READ THIS FIRST:   ADDENDUM TO THE HHCPC 
PROGRAMMING GUIDE 

 
 

 All references to HHC (Home Health Care) control panel refer to the AmberNA,  
 

 pg 14:  The following Toolbar icons appear differently in the manual then in the software 
 

 Download should be Send Data 
 Upload should be Get Data 
 Download Table should be Send Table 
 Upload Table should be Get Table 

 
 pg 17, 3.4 Communications Menu:  The following menu items appear incorrectly in the 

manual. 
 

 Download should be Send Data 
 Upload should be Get Data 

 
 pg 33, Section 7.2 = The Single User mode can handle up to 13 pendants, not 2 as it is 

written. 
 

 pg 34:  The Reminder Duration can be programmed between 0 - 5 minutes, not 1 - 5 minutes 
as it is written.   
 

 Pg 34:  The following features do not appear in the manual, but are in the software: 
 

 Fall Detector Warnings - the number of times that the POM-3000 will announce 
"User Has Fallen" when the fall detector has been tilted to an angle lower than 60 
degrees.  

 
 Fall Detector Warnings Delay - the amount of time in between each announcement 

of "User Has Fallen." 
 

 Blink On Reminder – when enabled, the LCD will blink during a reminder. 
 

 pg 36, Section 7.6 = This is the Reminders Section.  The note on the bottom should read as 
follows: 

 
Note: Up to 16 programmable reminders. If a specific reminder is ignored for the duration of 
the reminder (programmable under Panel Definitions), an emergency announcement is sent 
to the central station and a 2-way voice session is opened.  
 

 Please note that Sections 5.1 and 5.2 were removed intentionally and will note appear in the 
manual. 
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Copyrights & Warranty 
© Copyright 2005 by Visonic Ltd., 24 Habarzel Street, Tel-Aviv 69710, ISRAEL. All 
Rights Reserved. 

No part of this publication may be reproduced or distributed in any form or by any means, 
electronic or mechanical, for any purpose, without the express written permission of 
Visonic Ltd. 

Microsoft is a registered trademark of Microsoft Corp. 
All other products or services referred to in this manual are the trademarks, service marks, or 
product names of their respective holders. 

DISCLAIMER: The information, products and specifications, configurations, and other 
technical information regarding the products contained in this manual are subject to change 
without notice. All the statements, technical information, and recommendations contained 
in this manual are believed to be accurate and reliable but are presented without warranty of 
any kind, and users must take full responsibility for the application of any products 
specified in this manual. 
IN NO EVENT SHALL VISONIC OR ITS SUPPLIERS BE LIABLE FOR ANY INDIRECT, 
SPECIAL, CONSEQUENTIAL, OR INCIDENTAL DAMAGES, INCLUDING, WITHOUT 
LIMITATION, LOST PROFITS OR LOSS OR DAMAGE TO DATA ARISING OUT OF 
THE USE OR INABILITY TO USE THIS MANUAL, EVEN IF VISONIC HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 

WARRANTY 
Visonic Ltd. and/or its subsidiaries and its affiliates ("the Manufacturer") warrants its products 
hereinafter referred to as "the Product" or "Products" to be in conformance with its own plans 
and specifications and to be free of defects in materials and workmanship under normal use and 
service for a period of 12 months from the date of shipment by the Manufacturer.  The 
Manufacturer's obligations shall be limited within the warranty period, at its option, to repair or 
replace the product or any part thereof.  
This warranty does not apply in the following cases: improper installation, misuse, failure to 
follow installation and operating instructions, alteration, abuse, accident or tampering. 
This warranty is exclusive and expressly in lieu of all other warranties, obligations or liabilities, 
whether written, oral, express or implied, including any warranty of merchantability or fitness 
for a particular purpose, or otherwise.  In no case shall the Manufacturer be liable to anyone for 
any consequential or incidental damages for breach of this warranty or any other warranties 
whatsoever, as aforesaid. 
This warranty shall not be modified, varied or extended, and the Manufacturer does not 
authorize any person to act on its behalf in the modification, variation or extension of this 
warranty. This warranty shall apply to the Product only.  All products, accessories or 
attachments of others used in conjunction with the Product, including batteries, shall be 
covered solely by their own warranty, if any.  
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The Manufacturer shall not be liable for any damage or loss whatsoever, whether directly, 
indirectly, incidentally, consequentially or otherwise, caused by the malfunction of the Product 
due to products, accessories, or attachments of others, including batteries, used in conjunction 
with the Products. 
The Manufacturer does not represent that its Product may not be compromised and/or 
circumvented, or that the Product will prevent any death, personal and/or bodily injury and/or 
damage to property resulting from unauthorized entry, burglary, robbery, or otherwise, or that 
the Product will in all cases provide adequate warning or protection. User understands that a 
properly installed and maintained access control system may only reduce the risk of 
unauthorized entry without warning, but it is not insurance or a guarantee that such will not 
occur or that there will be no death, personal damage and/or damage to property as a result. 
The Manufacturer shall have no liability for any death, personal and/or bodily injury 
and/or damage to property or other loss whether direct, indirect, incidental, consequential 
or otherwise, based on a claim that the Product failed to function.  However, if the 
Manufacturer is held liable, whether directly or indirectly, for any loss or damage arising under 
this limited warranty or otherwise, regardless of cause or origin, the Manufacturer's maximum 
liability shall not in any case exceed the purchase price of the Product, which shall be fixed as 
liquidated damages and not as a penalty, and shall be the complete and exclusive remedy 
against the Manufacturer. 
 
Document revision 04/2005 
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About This Manual 
This manual provides a detailed description of the procedures for using the HHCPC with 
your HHC system. Consult HHCPC Programming Guides for additional information 
about specific programmable parameters. 
Chapter 1 provides an overview and briefly describes the system. 
Chapter 2 lists the requirements for installing the software and describes the software 
installation process. 
Chapter 3 covers the menus included in the software. 
Chapter 4 introduces Sites and how they are managed (creating, saving, deleting and 
copying). 
Chapter 5 explains how to use the First Installation and system reset features. 
Chapter 6 explains how to manage HHCPC users, including how to add users, delete 
users, change a user’s password and how to log in as a different user. 
Chapter 7 details all the different tables displayed in the software and provides a general 
overview of what is included in them. 
Chapter 8 describes how to edit text in the control panel LCD display. This chapter also 
explains how to perform automatic software upgrade. 
Chapter 9 describes how to connect to the HHC. This chapter details the different 
connection types and available settings, how to connect/disconnect to the HHC and what 
online functions are available when connected. 
Chapter 10 describes how to download/upload customized data settings. 
Chapter 11 covers the Reports utility, detailing how to define and generate reports. 
Chapter 12 describes how to change the screen appearance, change the screen color, 
column alignment and user interface language. 
Chapter 13 provides answers to troubleshooting questions, which may occur. 
Appendix A provides solutions in the event of characters not appearing correctly due to 
the interface language used. 
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Formatting Conventions 
The following formatting conventions are used throughout the documentation: 
Note: Additional information relevant to the presently 

discussed subject. 

Warning: 
Caution: 

Information that is essential for your safety and to avoid 
damaging the hardware or software. 

bold text Indicates operations that you must perform (e.g., name 
of a button to be clicked or option to be selected) or to 
emphasize a field or concept being described. 

 



Table of Contents _____________________________________________________________ 1 

 

Table of Contents 
Chapter 1: Introduction 

Chapter 2: Getting Started 
2.1 Hardware/Software Requirements ............................................................ 2-1 
2.2 Installation ................................................................................................ 2-1 
2.3 HHCPC Main Window............................................................................. 2-3 
2.4 Navigating HHCPC .................................................................................. 2-6 
2.5 Exiting HHCPC ........................................................................................ 2-6 

Chapter 3: Menus 
3.1 Sites Menu ................................................................................................ 3-1 
3.2 Edit Menu ................................................................................................. 3-1 
3.3 View Menu ............................................................................................... 3-1 
3.4 Communications Menu............................................................................. 3-2 
3.5 Utilities Menu ........................................................................................... 3-2 
3.6 Help Menu ................................................................................................ 3-2 

Chapter 4: Sites 
4.1 Introduction to Sites.................................................................................. 4-1 
4.2 Creating a New Site .................................................................................. 4-2 
4.3 Saving a Site ............................................................................................. 4-7 
4.4 Saving a Site File with a New Name ........................................................ 4-7 
4.5 Displaying and Editing Existing Sites Files ............................................. 4-7 
4.6 Copying a Site........................................................................................... 4-7 
4.7 Deleting a Site........................................................................................... 4-8  
4.8 Exiting the Site List Window.................................................................... 4-8 

Chapter 5: First Installation 
5.1 First Installation Procedure between the HHC and the Central Station.... 5-1 
5.2 First Installation Procedure between the HHCPC and the HHC .............. 5-2 
5.3 Remote Reset ............................................................................................ 5-3 
5.4 User Test Mode......................................................................................... 5-3 
5.5 Data/Time Updates ................................................................................... 5-3 
5.6 Clock Adjustment ..................................................................................... 5-3 
 



2 _____________________________________________________________ Table of Contents  

 

Chapter 6: Users 
6.1 Adding New Users.................................................................................... 6-1 
6.2 Deleting a User ......................................................................................... 6-1 
6.3 Changing User Passwords ........................................................................ 6-2 
6.4 Login as a Different User.......................................................................... 6-2 

Chapter 7: Data Details Table 
7.1 Site Information ........................................................................................ 7-1 
7.2 Panel Definitions....................................................................................... 7-1 
7.3 Diagnostics ............................................................................................... 7-2 
7.4 Communications Definitions .................................................................... 7-2 
7.5 Transmitters .............................................................................................. 7-3 
7.6 Reminders ................................................................................................. 7-3 
7.7 Event Log.................................................................................................. 7-4 

Chapter 8: Utilities 
8.1 Introduction to Utilities............................................................................. 8-1 
8.2 Editing Control Panel LCD Display Strings............................................. 8-1 
8.3 Software Upgrade ..................................................................................... 8-3 
8.4 Software Upgrade Statuses ....................................................................... 8-4 

Chapter 9: Connecting to the HHC Control Panel 
9.1 Defining Communication Settings............................................................ 9-1 
9.2 Connecting to HHC .................................................................................. 9-5 
9.3 Online Operations ..................................................................................... 9-5 
9.4 Disconnecting from the HHC ................................................................... 9-6 

Chapter 10: Data 
10.1 Defining Data Settings.......................................................................... 10-1 

Chapter 11: Reports 
11.1 Defining and Generating a Report ........................................................ 11-1 
11.2 Viewing a Report .................................................................................. 11-2 
11.3 Printing a Report................................................................................... 11-2 

Chapter 12: Screen Appearance 
12.1 Changing the Color............................................................................... 12-1 
12.2 Column Alignment ............................................................................... 12-2 
12.3 User Interface Language ....................................................................... 12-2 



Introduction_________________________________________________________________1-1 

Chapter 1: Introduction 
The HHCPC is a utility program that enables you to manage the HHC control panel from a 
remote station. It runs on PC workstations with Microsoft®  Windows 2000 or Windows 
XP.

It allows offline preparation of specifications, each of which is a set of parameters 
especially tailored for a particular HHCPC installation site. After the user has prepared the 
parameters for the site, they can be downloaded into the HHC control panel on the site. 

Data is transferred to and from the HHCPC either locally through an RS-232 serial data 
cable, as shown in figure 1-1, or remotely via telephone lines and a modem, as shown in 
figure 1-2. 

Local Data Transfer enables the operator to prepare the parameters for the HHC control 
panel on a PC where the operator specifies parame ters in the Site Screens, even though the 
operator is working at the same installation site. The operator then transfers the data to the 
control panel through a cable. 

LOCAL SETUP
no modem is
required for
local download

HHCPC

Figure 1-1: Setup for Local Data Transfer 

Remote Data Transfer enables the operator to work from a remote site where several HHC 
systems can be controlled at different installation sites. Using the HHCPC, the operator can 
compare the parameters of the different systems and copy them if necessary. The data is 
then transferred to each HHCPC through a modem. 

RS-232 CABLE

REMOTE SETUP-
EXTERNAL MODEM

EXTERNAL
MODEM

TEL. LINE

HHCPC

Figure 1-2: Setup for Remote Data Transfer with an External Modem 

Note: An external modem is required. It is recommended to use the approved model, 
USR 5686 or USR 5633 from US Robotics. 

Note: For UL installations, the HHCPC and the HHC unit must be located in the same 
room.

RS-232
CABLE

HHC

HHC
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Chapter 2: Getting Started  
2.1  Hardware / Software Requirements 

In order to run HHCPC, you need the following resources: 

• PC workstation with Pentium microprocessor (100 MHz or higher) 

• Microsoft Windows 2000 or Windows XP.  

• 128 megabytes of RAM (minimum) 

• Hard disk with at least 8 megabytes of free space. 

• For best performance, use a display driver with a resolution of at least 1024 x 768 pixels. 

2.2  Installation 
Use an RS-232 cable to connect an external modem to one of the computer’s COM ports as 
instructed in the manual supplied with the modem. Then connect the modem to the 
telephone line. 

To Install the Modem  

1. Install the modem for use with the remote computer. 

2. Restart your computer. In most cases Windows will detect the new hardware and 
will open a dialog box prompting you to install the driver for the new modem 
(from the manufacturer’s CD). 

If Windows does not recognize the modem during startup, do the following:  

3. From the Start menu, select Settings, then Control Panel; the control panel 
window appears.  

4. Double-click the Modems icon; the Modem Properties dialog box appears.  
Note: In Windows XP the Modems icon is located under Printers and other 
Hardware.  

5. Click Add; the Install New Modem wizard begins. Follow the instructions to 
enable Windows detect and install the new modem. 

To Install HHCPC  

1. Start Windows. Close all running applications, if any. 

2. Insert the HHCPC CD into the CD-ROM drive. 

 If your system includes the AutoPlay feature, the setup program starts 
automatically. Otherwise, proceed as follows: 
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3. From the Start menu, select Run; the Run dialog box appears.  

4. In the Run edit box, type the drive letter of the CD drive you are using, followed 
by a colon, backslash, and the word “setup”, for example: "d:\setup". 

5. Click OK. The installation welcome screen appears and the Installation program 
guides you through the entire process. 

6. Click Next, then follow the instructions on your screen to complete the 
installation.  

During installation an HHCPC shortcut icon is placed on the Desktop to 
enable you to start HHCPC easily. 

 

To Start HHCPC  

1. On the Windows Desktop, double-click on the HHCPC icon; the Login screen 
appears. 

 
Figure 2-1: Login Screen 

2. In the Operator edit box, enter your user name. 

3. In the Password edit box, enter your password. 

 Note: Contact Visonic technical support to obtain the software license, user 
name and password for your system. 

 Both entries are case-sensitive. 

 The main HHCPC screen appears with the Sites List in the foreground as the 
active window.  
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Figure 2-2: Site List Window 

This window enables you: to open an existing site file; create a new site file; copy a site 
file; delete a site file or exit the program. Refer to “Chapter 4. Sites” for further details. 

2.3  HHCPC Main Window 
The HHCPC main window displays all the main features of HHCPC. This enables you to 
manage the HHC control panel easily and efficiently.  

 
Figure 2-3: HHCPC Main Screen 

 

Menu bar 

Tool bar 

List of 
Tables 

Status bar 

Table Data 
Details 

Screen 
Tabs 

Title bar 
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Title Bar 
The title bar displays the following features: 

• The name of the HHCPC file that you have opened. 

• The windows Minimize button.  

• The windows Maximize button.  

• The windows Close button. 

Menu Bar 
Displays the menus that enable you to access HHCPC features. 

List of Tables 
This area displays a list of all the data tables containing information which characterizes the 
site. As you point to each table title, it appears underlined. Click on a title to display that 
table data. 

Table Data 
This area contains detailed data included in the selected table.  

Type in settings, or double-click on the down-pointing arrow to display a drop-down list, 
and select the appropriate value. 

Toolbar 
HHCPC provides a toolbar that displays buttons which are shortcuts to the most 
frequently used features of the system. 

Button Name Function Also 
accessible 
through menu 

 

New Displays the New Sites window. Sites 

 

Sites Displays the Sites List window (including Site 
information). 

Sites 

 

Save Saves the site file displayed on the screen. Sites 
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Search Displays the Sites window (without Site 
information). 

View Sites 

 

Options Displays the Options dialog box. View 

 

Back  Displays the previous table according to the List 
of Tables. 

View 

 

Next Displays the next table according to the List of 
Tables. 

View 

 

Login / 
Logout 

Connects/disconnects the HHCPC to/from the 
control panel. 

Communications 

 

Download Downloads the current configuration file (*.pmx) 
from the HHCPC to the control panel. 

Communications 

 

Upload Uploads the current configuration file (*.pmx) 
from the control panel to the HHCPC. 

Communications 
 

 

Download 
Table 

Downloads data from the table currently visible 
on the screen to the control panel. 

Communications 
 

 

Upload 
Table  

Uploads data from the control panel to the table 
currently visible on the screen.  

Communications 
 

 
First 
Installation 

Downloads configuration and specific customer 
audio files when the HHCPC connects to the 
Central Station for the first time. 

Communications 

 

Help Displays the HHCPC Help files. Help 

Status Bar 
The Status Bar appears at the bottom of the HHCPC screen. It displays the following: 
• Menu name 
• Caps lock 
• Number lock 
• Communication Status: The communication status is displayed by the color of the two 

communication status icons: 
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Program Status Left Icon Right Icon 

Communication is offline Gray Gray 

Communication is online Dark green Dark green 

Downloading to control panel Dark green Light green 

Uploading from control panel Light green Dark green 

• HHC model: Displays the HHC model name. 

2.4  Navigating HHCPC 
You can move around the HHCPC screen and carry out functions in a variety of ways: 

Mouse 
Use the mouse to point to a position on the screen, then click the left mouse button. This 
enables you to do the following: 

• Click a button. 

• Select a table tab in the main screen. 

• Place the cursor within a table edit box. 

• Display a drop-down list. 

Arrow keys 
The arrow keys enable you to move around the HHCPC tables and highlight the edit boxes. 
However, they do not position the cursor at the insertion point; this is performed using the 
mouse or by pressing Enter. 

2.5  Exiting HHCPC  
At any time, you can exit HHCPC.  

To Exit the Program 

1. From the Sites menu, select Exit. A popup message appears prompting 
you to save the recent changes to the system.  

2. Click Yes to save or No to disregard recent changes. HHCPC closes. 
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Chapter 3: Menus 
The HHCPC main screen displays six menus, which enable you to access the different 
features of the application. 

3.1  Sites Menu 
The Sites menu provides you with the tools to manage new and existing Sites. 

Menu Item Function 
List of Sites Displays the Sites window (with Site information). 
New Site  Displays the New Site window. 
Search  Displays the Sites window (without Site information).  
Save  Saves an existing Site file.  
Save As  Enables you to save a site file by a new name. 
Print  Prints a report. 
Print Preview  Displays the report on the screen before you print it. 
Print Setup Enables you to determine the Print specifications. 
Users  Enables you to manage users. 
Exit  Exits HHCPC. 

3.2  Edit Menu 
The Edit menu contains commands that help you edit and fill in details in each screen. 

Menu Item Function 

Cut Removes selected text to the clipboard. 

Copy Copies selected text to the clipboard. 

Paste Places the text being held in the clipboard at the point of insertion. 

3.3  View Menu 
The View menu contains items that enable you to control the appearance of your HHCPC screen. 

Menu Item Function 

Toolbar Displays or hides the Tool bar 

Status Bar Displays or hides the Status bar. 

Next Table Displays the next table of the List of Tables. 
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Menu Item Function 

Previous Table Displays the previous table of the List of Tables. 

Messages 
Window 

Displays the incoming and outgoing messages. 

Options Displays the Options window. 

3.4  Communications Menu 
The Communications menu enables you to manage the Communication process with the 
control panel. All of these functions appear on the toolbar.  

Menu Item Function 

Login/Logout Begins the login/logout process to/from the control panel. 

Download Downloads data from the HHCPC to the control panel. 

Upload Uploads data from the control panel to the HHCPC. 

Download Table Downloads the currently displayed table from the HHCPC to the control panel. 

Upload Table Uploads the currently displayed table from the control panel to the HHCPC. 

First Installation Downloads configuration and specific customer audio files. 

Audio Manager Enables you to download audio files to the HHC and to delete audio files 
registered in the HHC. 

Reset Control 
Panel 

Enables the user to reset the control panel. 

3.5  Utilities Menu 
The Utilities menu enables you to perform changes to the panel settings. 

Menu Item Function 

Translation Editor Enables the user to edit the panel display strings 

System Files Downloads system files (application, audio and language) 

System audio System audio files 

Delete all Deletes all system audio files. 

Download files Downloads system audio files. 

Download 
application 

Downloads application in online mode. Used for upgrading the HHCPC 
software. 

Download 
language 

Enables downloading of the required language (English or Spanish) file 

Upgrade panels Automatically upgrades software of all HHC panels. 
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UTILITIES

System
Audio

Download
Application

Download
Language

Delete All Download
Files

 

3.6  Help Menu 
The Help menu enables you to receive information and guidance in managing HHCPC. 

Menu Item Function 

Help Topics On-line Help to increase your knowledge about HHCPC, and help you use it 
to its maximum potential. 

About HHCPC Provides HHCPC copyright and version information. Click on the HHCPC 
logo to display our Home Page, which contains important information about 
using HHCPC. 

 

 

 

 

 
 



Sites ______________________________________________________________________4-1 

Chapter 4: Sites 
4.1  Introduction to Sites 

HHCPC enables you to manage Sites in a variety of ways. These features are accessible 
either from the menus or from the Site List window. 

The Site List window is displayed either when the program is first initiated, 
or by clicking the Sites button in the tool bar or by selecting List of Sites in 
the Sites menu.  

 
Figure 4-1: Site List Window 

This window displays a list of the site names whose files are located in the directory displayed 
in the Sites Location field. The first time the program is initiated, the path displayed will be 
the path where the HHCPC is installed on your computer. In later sessions, the Sites Location 
field will display the path last chosen (either typed in or selected using the Browse button). 
Using the Browse button, it is possible to locate and access a site file anywhere in the network 
and not just access site files saved to your local computer. 

Each column of the site list table can be sorted in either descending or ascending order by 
clicking on the column title. You can drag the vertical lines that separate the columns to 
enlarge or reduce the size of the columns. 
The screen displays buttons, which enable you to begin working with HHCPC: 

Button Function 
Open Opens an existing Site 
New Opens a new Site 
Delete Deletes a Site 
Exit Closes the HHCPC application. When you display the Sites List 

from within the system, the Exit button appears as a CANCEL 
button. This enables you to remove the Sites List from the 
screen, and continue using the application. 
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Button Function 
Browse Opens the Browse for Folder dialog box, which enables you to 

locate a folder where the Site files are located. 
Search Lists all the file names containing the text entered into the 

Search window. If "Look in sub directories" is not checked, the 
search will be performed only on Sites location (the root 
directory). 

4.2  Creating a New Site 
You can create a new, empty site file or you can copy an existing file, save it under a new 
name, and make the relevant changes to tailor it to a similar setup as the original. You can 
create a new site either via the Site List window or directly in the New Site window. 

1. Click New in the Site List window, 

 or 

 In the Sites menu, click New Site.… 

 The New Site dialog box appears.  

 

Figure 4-2: New Site Window - Work Online 

The New Site dialog box has two tabs:  

Work Offline: Enables defining and changing parameters offline and at a later time 
downloading these parameters to the control panel. 

Work Online: Enables direct operation with the control panel via a serial port or telephone 
modem.  

By default the New Site dialog box opens with the Work Offline tab open to enable you to 
create the configuration file before the installation.  



Sites ______________________________________________________________________4-3 

Working Offline 
Work Offline only if you know the HHC model you want to connect to. 

1. Select the Work Offline tab. The following screen will be displayed: 

 

Figure 4-10: New Site Window - Work Offline 

2. Select the relevant HHC model. 

3. Click OK. 

The HHCPC main screen will display the parameters relevant for the selected model. 

Working Online 

To work via a telephone modem 

1. In the New Site window click Options…. The Options Communications window 
appears. 
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Figure 4-3: Options - Telephone Modem Communications Mode 

2. Select Telephone modem in the Communications mode field. 

3. Ensure that the correct modem is selected and configured (see Chapter 8.1).   

4. Click OK. 

 The New Site window will appear displaying the Work Online tab with the 
Phone Number field enabled. 

 

Figure 4-4: New Site Window - Telephone Modem Mode 

5. Enter the Phone Number.  

 The Login button will become enabled. 
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6. Click Login. The Modem Dial Up... window will appear and attempt connecting. 

 
Figure 4-5: Modem Dial Up... 

7. Click Connect. The Hang Up button becomes enabled. 

 
Figure 4-6: Modem Hang Up 

8. Wait for two or three rings, then click the Hang Up button. 

 
Figure 4-7: Communicating with PC  
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The system will wait for 12 seconds and then will automatically dial again. The HHC 
will answer the call after the first ring and will initiate a data session with your PC. 

To work via a serial port 

1. In the New Site window click Options…. The Options Communications window 
appears. 

 
Figure 4-8: Options - Serial Port Communications Mode 

2. Ensure that Serial port is selected in the Communication mode field and that 
the serial port details are correct (refer to chapter 7: Connecting to the HHC 
Control Panel for further details). 

3. Click OK. 

 The New Site window will appear displaying the Work Online tab with the 
Phone Number field disabled. 



Sites ______________________________________________________________________4-7 

 
Figure 4-9: New Site Window - Work Online via a Serial Port 

4. Click Login. 

4.3  Saving a Site  
From the Sites menu, select Save, or click the Save button on the toolbar; HHCPC 
automatically saves the site file on which you are working. 

When you select Save or click the Save button for the first time after creating a new site 
file, HHCPC displays the Save As screen. 

 
Figure 4-11: Save As... Screen 

4.4  Saving a Site File with a New Name 
This enables you to save the site file with a new name and in a different directory. 

1. From the Sites menu, select Save As; HHCPC displays the Save As 
screen.  

2. Enter a suitable name for the new site and locate the directory where you 
want to save the file. 
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4.5  Displaying and Editing Existing Site Files 
Once you have created a site, and saved it, you can view it at any time.  

1. Either select the site from the recently used files in the Sites menu or 
select the site name to display in the Sites List window, and click Open.  

2. The HHCPC main window displays the information of the selected site. 

3. Edit the site tables as necessary. 

4.6  Copying a Site 
You can create a new site based on an existing similar site. This is done by copying an 
existing site file, saving it with a new name and then making and saving the necessary 
changes. 

1. In the Site List window, select an existing site file. 

2. Click Copy; an edit box appears prompting you for the name of the new 
site.  

3. Type the new site name, then click OK. 

 The HHCPC main window appears and displays the details of the copied 
site. 

4. Edit the site as necessary. 

5. Click Save to save the site. 

4.7  Deleting a Site 
When a Site is no longer active, and it is no longer necessary to store it in HHCPC, you can 
delete it. 

1. In the Sites List, select the site to delete, then click Delete, a warning box 
appears reminding you that any account that you delete is not retrievable. 

2. Click Yes to delete the account, or No to return to the Sites List. 

 If you click Yes, the selected site is deleted and the Sites List is displayed. 

4.8  Exiting the Site List Window 
When you open HHCPC, the Sites List displays an Exit button. However, when you 
display the Sites List from within the application, the Exit button is replaced by a Cancel 
button. 

Click Exit to exit HHCPC.  

Click Cancel; the Sites List closes, and the main HHCPC screen becomes active. 
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5.3  Remote Reset  
The remote reset feature enables you to reset all configurations made to the HHC. When 
performing remote reset, the system saves all database and event log files. 

To Perform Remote Reset 

From the Communications menu, select Reset Control Panel, then select Remote Reset. 

5.4  User Test Mode 
The system enters this mode automatically each time the unit calls the central station. This 
enables the user to perform a Walk Test using an RF device. Each time the device button is 
pressed, the Base Station will announce the name of the customized audio file attached to 
the specific user name, or, it will announce the device type if no audio file was attached. 

If no audio file was attached, the HHC will announce the device type (pendant, smoke 
detector or fall detector) and its order number in the device table. 

At the end of the voice session, the HHC will report all activities to the central station log. 

5.5 Date/Time Updates 
After completing the first installation, the PC clock is updated to the correct date and time. 
The date and time are updated each time the HHCPC is logged into the unit. 

5.6 Clock Adjustment 
The clock is displayed in 12-hour format, in the following structure: HH:MM:SS. The date 
is set as MM/DD/YYYY. For example, if the time is 8:30PM and the date is January 15, 
2004, the display reads 01/15/2004 08:30:00 PM.  

To Set the Clock 

1. Press the Check button three times to enter clock adjustment mode. The top line, 
assigned to the Month indication, will start to flash. 

 

2. Use Speed Dial buttons 1 (scrolls up) and 2 (scrolls down) to set the current 
field value. 

3. Press Speed Dial button 3 to scroll to select other fields: month, day, year, 
hours, minutes, and seconds. 

4. Press the Check button to set a new date or time value. 

Note: Press the Call (Escape) button at any time to return to normal operation 
mode. This does not affect current time/date settings. 

01/15/2004 
08:25:53 PM 
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Chapter 6: Users 
From the Sites menu, select Users; HHCPC displays a menu that enables you to manage the 
HHCPC users. 
Menu Item Enables you to: 

Add new user Add a new user name and password. 

Delete user Delete a user. 

Change 
password 

Change an existing user’s password. 

Login as different 
user 

Login as a different user without exiting HHCPC. 

6.1  Adding New Users 
1. From the Sites menu, select Users, then Add new user; the Add new user 

dialog box will appear. 

 
Figure 6-1: Add New User Dialog Box 

2. In the User Name edit box, type the user's name. 

3. In the Password edit box, type the user's password. 

4. In the Confirm Password edit box, retype the user's password. 

5. Check the Full Access checkbox to enable the user to create and delete other 
users. If this is not checked, the user will have access to all the sites, but will not 
be able to create or delete other users. 

6. Click Add; a message box appears confirming the addition of the user to the 
system. 
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6.2  Deleting a User 
1. From the Sites menu, select Users, then Delete user; the Delete user dialog box 

will appear. 

 
Figure 6-2: Deleting User Name Dialog Box 

2. In the User Name edit box, type the user's name.  

3. In the Password edit box, type the user's password. 

4. Click Delete; a message box appears confirming the deletion of the user from 
the system. 

6.3  Changing User Passwords 
1. From the Sites menu, select Users, then Change Password. The Change 

Password dialog box appears. 

 
Figure 6-3: Changing User Password Dialog Box 

2. In the User Name edit box, type the user's name. 

3. In the Old Password edit box, type the user's current password. 

4. In the New Password edit box, type the user's new password. 

5. Click Change; a message box appears confirming the user password change. 
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6.4  Login as a Different User 
1. From the Sites menu, select Users, then Login as a different user; the HHCPC 

Login screen appears. 

2. In the User Name edit box type the user's name and in the Password edit box 
type the user's password. 

3. Click OK; a message will appear to notify that the password has been changed 
successfully.  
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Chapter 7: Data Details Tables 
The data details tables display the parameters that can be uploaded from or downloaded to 
the HHC control panel. When first creating a site file, the values displayed are default 
values, which can be altered to suit the specific system.  

Use the arrow keys to navigate between the cells and focus on the different parameters, 
then click the left mouse button or press ENTER to edit the cell and change the values.  

HHCPC includes the following tables:  
• Site Information 
• Panel Definitions 
• Diagnostics 
• Communications Definitions 
• Transmitters 
• Reminders 
• Event Log 

7.1  Site Information 
This section provides various types of information on HHCPC sites, including site 
connection and location details. 

Site Information - Displays general information about the site control panel. 

Base Station Name - The name of the station where the control panel is installed. By 
default this field receives the name of the HHC model detected. 

Address, City, State, and Zip Code - The complete address of the site. 

Base Station Phone - The telephone number which the HHCPC uses to connect to the 
control panel. 

Additional Information - Additional important information about the HHCPC site and 
facilities. 

7.2  Panel Definitions 
Panel Definition enables you to customize the control panel and adapt its characteristics 
and behavior to the requirements of the particular user. 

Operational Mode - Various operational modes used in HHCPC, as follows: 

• Single User is used for the configuration of up to 29 detectors, out of which two 
personal detectors (Pendant or Fall Detector).  



7-2___________________________________________________________Data Details Tables  

• Multi User is designed for use in institutions and enables you to enroll up to 29 
detectors. (Does not support Device Test Check or Reminders.) 

• Fire Only acts only as a fire alarm and is used in conjunction with most detectors 
except for personal detectors (for example, pendant and fall detectors). (Does not 
support Device Test Check and Custom Audio Files or Reminders.) 
Note: When moving between the above three operational modes, the data entered into 
the previous operational mode will become invalidated if it contradicts the conditions 
of the current operational mode. An error message will then appear on the screen. 

• Common Area enables you to enroll up to 255 detectors. The first 29 enrolled 
detectors may be of any type. Detectors 30 -255 must be personal detectors only. 
Note: When switching from the Common Area mode to any other mode (and vice 
versa), all data entered by the user will be deleted. 

Language – Select English (default) or Spanish.  

Time and Date Format – USA time and date format. 

Time Zone Gap – Set the difference in time (in hours) between the location of the HHCPC 
system and the location of the HHC (0 by default).  

Automatic Daylight Saving – Enables/disables automatic adjustment to daylight saving 
time. 

Keypad Sound – Keypad sound is always ON. 

Trouble Announcement – Define the duration of time for trouble announcement. Enables 
you to provide definitions for daily, weekly, monthly and yearly periods of time. 

Reminder Duration – The duration of time the reminder is sounded (1 - 5 minutes). 

Inactivity Window 1 – Define first activity beginning and end times. 

Inactivity Window 2 – Define second activity beginning and end times. 

Panel Audio Name – provides audio announcement of panel name. It enables you to select 
a (.aud) file to be downloaded.  

7.3  Diagnostics* 
Diagnostics provides details of the control panel and items connected to the control panel. 

Control Panel Serial Number – Production serial number of control panel 

Control Panel Software Version – Current software version of control panel 

Control Panel Hardware Version – Current hardware version of control panel 

Control Panel Manufacture Date Code – Special code unique to each HHC unit 
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Pendant ID – Pendant ID number 

Power Charger Status – Provides battery life status. 

* All paramaters are read-only. The parameters of the Diagnostics are updated when 
performing upload table. 

7.4  Communications Definitions  
Communications Definitions enables you to set the telephone communication parameters to 
the requirements of the particular Site. The CPC feature provides recognition of call 
termination at the other end of the line.  

Outside line number – If relevant, the HHC adds this number to the dialed telephone 
number. 

Reporting to – The HHC reports all types of events to the central station or to a private 
telephone number. 

Primary User Account – After dialing Emergency Tel #1, enter this code at the prompt 

Emergency Tel #1 – In the event of an emergency, dials the first stored emergency number 

Secondary User Account – After dialing Emergency Tel #2, enter this code at the prompt 

Emergency Tel #2 – In the event of an emergency, dials the second stored emergency 
number 

Ring Time (minutes) – The period, in minutes, during which the central station can 
establish 2-way voice communication with the HHC (2 min. by default). 

Central Station Dialing Attempts – Number of dialing attempts to the central station. 
First call is to Emergency Tel #1; second call is to Emergency Tel #2 (16 by default). 

1st private – dials first private telephone number 

2nd private – dials second private telephone number 

3rd private – dials third private telephone number 

4th private – dials fourth private telephone number 

Private Dialing Attempts - Number of dialing attempts to private telephone numbers. First 
call is to Private Tel #1; second call is to Private Tel #2 (4 by default). 

Contact Check Time – Schedules a daily “Contact Check” to assure that the base unit can 
communicate with the central station. The time is scheduled automatically by the HHCPC. 

CPC Signal Detection – Select Enable or Disable to activate/deactivate the CPC 
termination of a call feature. This feature also enables the installer to adjust the CPC 
detection per telephone service provider.  

CPC Threshold Minimum (0 – 500 ms) – Define the minimum threshold time upon CPC 
recognition, in milliseconds, for disconnecting the telephone line.  
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CPC Threshold Maximum (0 – 900 ms) – Define the maximum threshold time upon CPC 
recognition, in milliseconds, for disconnecting the telephone line.  

Direct Link Tel #1 – HHC dials the telephone number stored in memory location 1. 

Direct Link Tel #2 – HHC dials the telephone number stored in memory location 2. 

Direct Link Tel #3 – HHC dials the telephone number stored in memory location 3. 

7.5  Transmitters  
This feature enables you to enroll up to 29 RF devices. 

Active – Notifies if the enrolled device is active or not active. 

Device Type – Select the device type 

RF ID # – Transmission ID number. 

Name – Name displayed on particular RF device. 

Device Audio – Click to select the corresponding audio file to the particular RF device. 

Device Test – Determines the frequency of performing checks on the RF device. 
Current RF Level – The result of the current diagnostic test 
Previous RF Level – The result of the previous diagnostic test 
Note: To delete an RF device from the HHC, select Not Active from Entry Status. 

7.6  Reminders 
This feature enables you to set up to 16 programmable reminders per day. The reminder is 
announced by a voice message and also appears on the HHC LCD display. 

Active – Notifies if the enrolled device is active or not active. 
Reminder Schedule – Enables you to set a recurring reminder: daily; weekly; monthly; or 
yearly. 
Reminder Type - Select one of the following reminder options: 

• Medication  

• Health Test  

• Wellness Check 

• Wake Up Call 

• General Reminder  
Note: Up to 16 programmable reminders.  If a specific reminder is ignored five consecutive 
times, an emergency announcement is sent to the central station giving the contact ID and 
zone number. 
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User Name – Displays the name of the person to whom the reminder is intended. 
User Name Audio – Provides a voice message emitting the user name. 
Displayed Message – Displays the contents of the message. 
Audio Message – Provides a voice message emitting the contents of the message. 

7.7  Event Log 
The HHC maintains a log file of all occurred events. The event log can be uploaded to the 
HHCPC. 
Index # – Lists events in numerical order. 
Event – Type of event. 
Zone # – Displays the wireless device number or whether it was a system event. 

Date and Time – Displays the date and time of the event. 

To upload the event log table 

1. Perform login. 

2. Select the Event Log table. 

3. Click the Upload Table icon on the toolbar 

The HHCPC uploads all events in the table. A log file can contain up to 100 events in FIFO 
format (first-in, first-out), whereby new events overwrite the oldest events.   
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Chapter 8: Utilities 
8.1  Translation Editor 

HHCPC enables you to perform text changes to the control panel in a variety of ways. 
These features are accessible from the Utilities menu. 

The Translation Editor window is displayed by selecting Translation Editor in the Utilities 
menu. The text that appears on the HHC window is comprised of two rows, with up to 16 
characters on each row. Rows marked in gray cannot be edited. Rows marked in purple 
may be edited only where there are no asterisks. 

 
Figure 8-1: Translation Editor Window 

8.2  Editing Control Panel LCD Display Strings 
This window enables you to edit the strings on the LCD display and also to translate the 
strings from English into a different language. 

1. Click the Def button to upload the LCD string definitions file (usually titled 
language.def). 
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Figure 8.2: Translation Editor Window – Typing Text 

2. Click the Lang button to load an existing file to be edited, by selecting the 
required (.lng) file from the opened window, 

or 

Simply type the required text in the empty rows. 

 
Figure 8.3: Translation Editor Window – Editing Existing Text  

3. Edit the file, as required. 

4. Click the Save button. 

5. From the Utilities menu, select System Files, then Download Language.  

6. Download the relevant (.lng) file. This will update the control panel LCD 
display strings. 

Definition  
of text on  
LCD display 

Text that  
appears on  
LCD display 

Definition  
of text on  
LCD display 

Text that  
appears on  
LCD display 
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8.3  Software Upgrade 
HHCPC enables you to automatically upgrade HHC control panels. 

1. From the Utilities menu, select Upgrade Panels; the Software Upgrade dialog 
box will appear. 

 
Figure 8.4: Software Upgrade Dialog Box  

2. In the Telephone number List File section of the dialog box, click the Browse 
button and select the file containing the control panel's telephone number. 

3. In the Application File section of the dialog box, click the Browse button and 
select the .hex file to be downloaded. 

4. In the Extra dialing information section of the dialog box, enter the prefix used 
before dialing the telephone number, if required. 

5. Click the Start button; HHCPC begins to automatically upgrade all the HHC 
control panels in the system. 

Note: Click the Stop button to end the automatic upgrade procedure. To 
temporarily stop the procedure, click the Pause button, then click the Start 
button again to resume. 

6. When the procedure is completed, click the Exit button. 
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Note: The telephone file format is as follows:  

• A line must not exceed 256 charters. 

• A line should always display first of all the telephone number (0-9 plus the 
character '-'), then any additional text. Each telephone number is restricted 
to a maximum of 16 digits. 

• After inserting the telephone number, there must be a space, after which you 
may insert a remark, if desired. 

The following table provides a list of possible statuses that appear in the file while the 
software upgrade procedure is running. A status appears at the end of each row 
immediately following "####". 

Status Definition  
OK  Procedure completed OK  

COMM ERROR Communication error during download 

NO ANSWER Control Panel did not answer 

BUSY A busy modem signal received 

NO CARRIER Control Panel did not answer 

NO DIAL TONE No telephone line is connected to modem 

USER CANCEL User stopped the procedure 

GENERAL ERROR Modem error 

<empty> Not processed yet 
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Chapter 9: Connecting to the HHC 
Control Panel 

Connecting to the HHC control panel enables the HHCPC to transfer information to and 
from the control panel. The control panel can be connected by remote connection (via 
telephone modem), used when the operator specifies the parameters off-site, or by local 
connection (via RS-232), used when the installer uses a PC to specify the parameters 
on-site.  

Once connected, it is possible to perform a number of operations, such as, uploading site 
parameters, downloading site parameters or changing system date and time.  

9.1  Defining Communication Settings 
The Communications dialog box enables you to determine the communication settings by 
which the HHCPC and the control panel will communicate. 

From the View menu, select Options, then click on the Communications tab; the 
Communications dialog box appears. 

 
Figure 9-1: Options - Communications Tab 
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9.1.1 Local Connection (Serial Port)  

Local connection is used when the HHCPC is within direct cable connection distance from 
the HHC control panel. When using Local Connection there is no need for a modem. Only 
communication ports without installed modem drivers may be used in Serial mode. For 
example, if the modem drivers are installed on the ports COM2 and COM3, then ports COM1 
and COM4 may be used for connection in Serial mode. 

1. From the Communications mode drop-down list, select Serial Port. The serial 
port parameters are displayed as follows: 
• The Comm port field becomes enabled. 
• The Baud rate field displays 115200, this being the baud rate used for serial 

connection. The Baud rate field is disabled. 
• The Parity and the Stop bits fields do not change and are disabled. 

 
Figure 9-2: Communications Mode - Serial Port 

2. Change the Comm port field as necessary. 

3. Click OK. 
  

9.1.2 Remote Connection (Telephone Modem)  
This is applicable when the HHCPC is off-site and when using a telephone modem to connect 
to the HHC on-site. 

1. From the Communications mode drop-down list, select Telephone Modem. 
The telephone modem section becomes enabled, and the serial port parameters 
change automatically to be displayed as follows: 
• The Comm port field becomes disabled and the field value is the 

communications port where the modem is connected. 
• The Baud rate field displays 115200, the baud rate used for telephone modem 

connection. 
• The Parity and the Stop bits fields do not change and are disabled. 
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Figure 9-3: Communications Mode – Telephone Modem 

2. In the Telephone Modem section of the dialog box, select from the Modem 
drop-down list, the modem to use for connecting to the control panel. 

3. Click Settings to display the Modem Settings dialog box, and define the dialing 
and modem parameters. 
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Figure 9-4: Modem Settings 

4. To connect to the HHC modem, the local software initiates the dialing process. 
This process includes a number of steps: 

 Step 1: Dialing. 

 Step 2: Waiting 2-4 rings (The dialing process ends if connection is made). 

 Step 3: Hanging up. 

 Step 4: Waiting a number of seconds before trying again. 

 Step 5: Beginning the dialing process again. 

 The Try to connect field defines the number of times the dialing process should 
be initiated (step 1-4). The Wait for 2-4 rings during field defines the time 
allocated for the two to four telephone rings (step 2). This time needs to be 
defined as different telephone systems/modems take different amounts of time to 
carry out the rings. 

 Tip: If you are not sure of the time to enter in the Wait for 2-4 rings during 
field, enter a high number (i.e. 100 seconds), initiate connection as detailed in 
Connecting by Remote Connection in this chapter, time on your watch the 
number of seconds your modem takes for 2 rings and then click Hang Up. Enter 
the number of seconds you timed in the Wait for 2-4 rings during field. 
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9.2  Connecting to HHC 
The login procedure enables HHCPC to transfer information to and from the control panel 
and can be initiated either when creating a new site file or when a site file is already open. 
This procedure differs when the communications mode is set to Serial Port or Telephone 
Modem. The first part of the procedure is the same for both types of communication 
modes: 

To Login when creating a new site file  

1. Select New Site from the Sites menu, 

 Or 

 Click New in the Sites window. 

2. In the New Site (work online) dialog box, fill in the fields (the fields will be 
enabled/disabled according to the communication mode). 

3. Click Login. 

To Login when a site file is open 

From the Communications menu select Login, 

Or  

Click the Login icon in the toolbar. 

Performing Local Connection (Serial Port)  
After connecting, the communication icons in the status bar will become green, and the 
Download and Upload icons in the toolbar become enabled and you have successfully 
logged in. 

9.3  Online Operations 
While connected to the HHC, it is possible to perform a number of different operations. 
You can transfer information between the HHCPC and the control panel by uploading or 
downloading, either all site parameters or a specific table. It is also possible to update the 
system date and time. 

To Download or Upload All Site Parameters 

From the Communications menu, select Download or Upload,  

Or 

Click the appropriate icon on the toolbar.  
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The system begins to transfer data between the control panel and the HHCPC. The wording 
on the message box changes according to whether the transfer is upload or download. 

 
Figure 9-5: Uploading/Downloading Progress Bar Screen 

At any point during the transfer, you can click Cancel to halt the procedure. 

When the transfer is complete, a message box appears to confirm successful completion. 

To Download or Upload a Specific Table 

1. Select a table by clicking on a table name in the List of Tables area, or by 
clicking a table tab at the bottom of the screen. 

2. From the Communications menu, select Download Table or Upload Table, or 
click the appropriate icon on the toolbar.  

Using the Audio manager 

The Audio Manager handles all custom audio files for each control panel. 

1. From the Transmitters and Reminders tables, select the custom audio (.aud) files to 
be included in the control panel. 

2. From the Communications menu, select Audio Manager; the Audio Manager 
dialog box appears. 

3. Select the custom audio files you wish to download and click the Download button 
to download the files. 

4. Click the Delete All Files button, to delete all customized files from the HHC  

Note: The Download and Delete All Files buttons are enabled only after performing 
login. 
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Figure 9-6: Audio Manager Dialog Box 

5. Click the Up / Down buttons to move files from the "Files waiting to be 
downloaded" section to the "Downloaded Files" section and vice versa. 

6. Click the Remove button (out of two) to delete files that appear only in the 
Audio Manager window. 

Note: See the Utilities menu for other functions which are performed online. 

9.4  Disconnecting from the HHC 
From the Communications menu, select Logout,  

Or 

Click the Logout icon on the toolbar. 
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Chapter 10: Data 
The data tab is used to define specific upload/download settings to facilitate data transfer.  

10.1  Defining Data Settings 
The Data dialog box enables you to customize specific data settings in the 
upload/download process. 

From the View menu, select Options, then click on the Data tab; the Data dialog box 
appears. 

 
Figure 10-1: Options – Data Tab 

1. Check the Send updated data immediately field, to automatically update 
changed settings from the HHCPC to the HHC. 

 Note: If the above field is not checked, the HHC will only be updated when 
performing full download. 

2. In the Delay after acknowledge during download field, enter a time value (in 
milliseconds) for a delay in sending commands.  

3. In the Delay after acknowledge during download field, enter a time value (in 
milliseconds) for a delay in sending commands. 

Note: This field should be used when problems in communication are experienced. 
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Chapter 11: Reports 
After you have created a site, you can generate a printable report of the site data. To 
generate a report, first define the information to include in the report, preview the report 
and then print it. 

11.1  Defining and Generating a Report 
Each HHCPC account comprises of 7 tables. You can generate a report including 
information about some or all of these details. After you specify which details you require 
in the report, HHCPC will generate the report. 

To Define and Generate a Report 

1. From the View menu, select Options, or  

 Click the Options button on the toolbar; the Options dialog box appears. 

2. Click the Reports tab; the Reports dialog box appears. 

 
Figure 11-1: Options – Reports 
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Mark the relevant check boxes to specify the information to include in the Report. 

3. Click Apply; the tables to include in the report are selected, and the Reports 
dialog box remains on the screen for further perusal and selection. 

4. Click OK; HHCPC generates the report according to your specifications. 

11.2  Viewing a Report 
HHCPC enables you to view reports before you print them. This enables you to check that 
you have included all the necessary information in the report. 

To View a Report  

From the Sites menu, select Print Preview. 

HHCPC displays the report of the site on the screen as you have specified for printing in 
the Options dialog box. This enables you to view the different details of the report before 
you print it. 

The Print Preview toolbar enables you to do the following: 
Print Prints the report from the Print Preview screen. 
Next Page Displays the following page of the report. 
Prev Page Displays the previous page of the report. 
First Page Displays the first page of the report on the screen. 
Last Page Displays the last page of the report on the screen. 
Whole Page Displays one page of the report on the screen. 
Page Width Fits the page to the width of the window. 
Two Pages Displays two pages of the report on the screen. 
Thumbnail Opens a navigation pane of thumbnails of each report. 
Zoom  Increases the size of the report as it appears on the screen. There 

are five possible view sizes available. 

11.3  Printing a Report 
You can change the print setup for a report. This enables you to determine the following: 
• The printer to print the report. 

• The paper size on which to print. 

• The source from which the printer should take paper. 

• The orientation of the paper. 
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To Determine the Print Setup 

1. From the Sites menu, select Print Setup; the Print Setup dialog box appears. 

2. Specify the printer to where the report will be printed. 

3. Specify the paper size of the paper on which the report will be printed. 

4. Specify the paper source. 

5. Specify the orientation of the paper. 

6. Click OK. The window is closed. 

To Print a Report 

1. From the Sites menu, select Print (or click the Print button on the toolbar); 
HHCPC displays the Print screen.  

 
Figure 11-2: Print Dialog Box 

This screen enables you to do the following: 

• Select the printer to print the report. 

• Determine the print range. 

• Determine the number of copies of the report, and whether or not they should be 
collated. 

2.  Make the appropriate changes, then click OK; HHCPC prints the report. 
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Chapter 12: Screen Appearance 
Any changes to the appearance of the Site screens are made in the Display tab of the 
Options dialog box. 

 
Figure 12-1: Options - Display Tab 

12.1  Changing the Color 
The colors of the Table Details are defined according to the following settings: 

• Table zebra color: Defines the color of every other line in each table. This makes it 
easier for the user to follow the horizontal lines in the table.  

• Table disabled option color: Disabled tables appear in the selected shade. 

• Table normal option color: The color of the text as you type it. 

• Background color: The background color of the tables list and the sites list. 

To Change the Tables Color 

1. From the View menu, select Options; the Options dialog box appears. By 
default, the display tab is active. 

2. Click on the block of Tables zebra color; the color palette appears. 

3. Select a color, then click OK. 

4. Repeat the procedure for all the options. 

5. Restart HHCPC. 
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12.2  Column Alignment 
HHCPC defines the Table Details column alignment according to one of the following 
settings: The Tables Column Alignment determines the width of the table columns on the 
screen. 

• No auto alignment: All columns in the tables are the same width, regardless of their 
contents. 

• Right justified: The columns in the table are all widened in order to cover the entire 
screen. 

• Last column stretched: The last column in the table reaches the right side of the screen, 
however wide the contents of the column. 

• Additional column: An additional column is added to the tables that are too narrow to 
fill the screen. The extra column is the width of the empty space between the last 
column of the table, and the right side of the screen. 

To Change the Tables Column Alignment 

Click the column alignment drop-down arrow, then select an option from the list. 

12.3  User Interface Language  
HHCPC provides you with the possibility to change the language used in the software 
interface.  

To Change the User Interface Language 

1. Click the Language User Interface language drop-down arrow, then select a 
language from the list.  

2. Restart HHCPC. 
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Chapter 13: Troubleshooting 
PROBLEM DIAGNOSIS POSSIBLE SOLUTION 

A.  The HHCPC 
doesn't identify the 
modem 

A1. Your modem 
might be OFF or 
loosely 
connected.  

A1. Make sure the modem is turned ON. A 
power switch is available on any external 
modem. The light on the front panel should 
illuminate.  
Also ensure that all other applications using 
the COM Port are turned off (PalmPilot 
Hotsyc and other accessories or terminal 
windows). 
Check whether the cable connectors are 
fitted securely to their respective ports: 
• The line connector in case of an internal 

modem  
• The line and RS-232 connectors in case 

of an external modem.  
 A2. You may have a 

COM\IRQ 
conflict. 

A2. Check whether you have the correct Com 
port and IRQ settings in your software 
and/or in the Windows Control Panel. Also 
verify that there are no conflicts with other 
devices. 

B.  Failure to com-
municate with the 
HHC via the 
modem.  

B1. You may have a 
conflict with the 
definitions in the 
communication 
mode window. 

B1. Make sure you selected the Telephone 
Modem option in the communication mode 
window.  

 B2. The modem type 
is different from 
the type displayed 
in the OPTIONS 
menu / Com-
munications tab. 

B2. Check that the correct modem type has been 
selected. 

 

 B3. Modem is not 
properly installed 
in operating 
system 
(Windows). 

B3. Make sure that the modem is recognized by 
Windows.  

  If not, click Start → Setting → Control 
Panel. Double click the Modems icon and 
follow the instructions on the displayed 
Install New Modem window. 
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PROBLEM DIAGNOSIS POSSIBLE SOLUTION 
 B4. HHC is not 

connected to the 
phone line. 

B4. Verify proper connection of the HHC to the 
phone line. 

C.  PC fails to 
communicate with 
the HHC via the 
Serial Port.  

C1. The RS-232 cable 
is disconnected 
from the Com 
Port of your PC. 

C1. Verify proper connection of the RS-232 
cable.  

 C2. You may have a 
definition conflict 
in the OPTIONS 
menu/ Commun-
ications settings 

C2. Make sure that the Serial Port option is 
currently selected. 

 

 C3. Your serial port is 
defined to work 
with high or low 
baud rate. 

C3. Make sure 115200 bps option is currently 
selected in the OPTIONS menu / 
Communications.  

 C4. You may have a 
COM Conflict. 

C4. Verify that the correct Com Port is specified 
in the OPTIONS menu / Communications 

D.  The unit stalls 
during 
configuration or 
remote 
programming. 

D1. The HHC needs 
to be reset. 

D1. Press, simultaneously, the three main buttons 
on the HHC for 10 seconds. 
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Appendix A: Language Settings 
When using the HHCPC Software in Windows 2000/XP with a foreign language interface, 
some characters may not appear correctly in the chosen language. This may require 
changing the language settings. 

Changing Language Settings in Windows 2000 

1. From Start>Settings>Control Panel double-click Regional Options. The 
Regional Options dialog box appears. 

 
Figure A-1: Regional Options Window 

2. Click Set Default; the Select System Locale dialog box appears. 

 
Figure A-2: Select System Locale Window 
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3. Click the drop-down list and select the appropriate language. 

4. Click OK. 

5. Restart the computer. 

Changing Language Settings in Windows XP 

1. From Start>Settings>Control Panel double-click Regional and Language 
Options. The Regional and Language Options dialog box appears. 

 
Figure A-3: Regional and Language Options Window 

2. Click on the Advanced tab. 

3. Under Language for non-Unicode programs, click the drop-down list and 
select the appropriate language. 

4. Click OK. 

5. Restart the computer. 
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